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Capítulo 1 Interface do Software 
 
1.1 Interface Principal 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

1.2 Barra de Menu 
    

 
 
1) File (Arquivo) 
 
A opção de menu “File” (Arquivo) inclui: 
 
Open (abrir uma planilha salvada) 
Close (fechar a planilha) 
Save (salvar planilha) 
Save As (salvar como uma nova planilha) 
Exit (sair CardDésirée CS) 

Barra de Ferramentas 

Editar Região

Barra do Menu Bar

Ferramenta 

Quadro de ID Frame 

Camada 

Pré-visualização
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2) Edit (Editar) 
O menu“Edit” (Editar) inclui: 
Cut (Cortar) 
Copy (Copiar) 
Duplicate (Duplicar) 
Paste (Colar) 
Delete (Deletar) 
Push layer to top (Empurrar camada para cima) 
Push layer to bottom (Empurrar camada para baixo)  
Bring Forward (Trazer para frente) 
Send Backward (Enviar para trás) 

Layer positioning (Posicionamento de camada) 

(Define a posição e a camada) 
 Unidade : pixel ou 1/10mm  
 x：Define posição horizontal 
 y：Define posição vertical 
 Width (Largura)：Define a largura de uma camada 
 Height (Altura)：Define a altura de uma camada 
　 Alinhamento : Existem 9 botões para o alinhamento : 
    Superior esquerdo, Superior Central, Superior Direito,  
    Centro esquerdo, Centro, Centro direito, Inferior esquerdo, Inferior central e   
    Inferior direito. 
 
3) View (Vista) 
A opção de menu “View” (Vista) inclui:  
Rulers (Réguas) (mostra/esconde regras) 

  

 
Grid line (Linha Entrecruzada) (mostra/esconde linhas entrecruzadas) 
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4) Add (Adicionar) 
Background (Fundo) (importa um fundo) 
Color Text (Texto Colorido) (adiciona um texto colorido) 
Resin  Text (Texto em Negrito) (adiciona um texto em negrito) 
BarCode (Código de Barra) (importa um código de barra) 
ID Frame (Quadro ID) (adiciona um quadro de id) 
E-frame (quadro-e) (adiciona um quadro-e) 
Line (Linha) (adiciona uma linha) 
Graphic (Gráfico) (adiciona uma figura) 
 
5) Codificação 
Cartão Inteligente de Contacto  
Cartão Magnético 
Contactless Smart Card 
 
6) Banco de Dados 
A opção de menu “Database” (Banco de Daos) inclui: 
Connect Database (Conectar Banco de Dados) 
Record (Registro) (browse each data) 
Record list (Lista de Registros) (mostra a lista de banco de dados) 
Dynamic Mode (See Chapter 4.5) 
Layer Mapping (Mapeamento de Camada) (mapeia a fonte de dados de cada camada) 
 
7) Help (Ajuda) 
  Arquivo“Help＂(Ajuda)  & “About CardDésirée CS＂ 
  (Sobre CardDésirée CS)  
 
1.3 Selecionar Modelo de Impressora, Tipo de Cartão & Orientação 

 Selecionar Modelo de Impresora de Cartão, Tipo de Cartão    

 
  1) Selecionar impressora  

          
CardDésirée CS suporta ambos HiTi CS-300, HiTi CS310, HiTi CS320, HiTi 640DL-
Amphi, HiTi Amphi II 
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[Advertência!!]: Por favor, escolha a impressora correta antes de editar. Devido à 
diferença em resolução, a transferência de formatos entre os dois modelos pode não 
ser consistente.  

  2) Selecionar tipo de cartão 

     
 Os tipos de cartões que CS Series suporta até agora são: 

A. Cartão em branco 
B. Cartão Chip Inteligente de 6-pin 
C. Cartão Chip Inteligente de 8-pin 
D. Cartão com Tira Magnética  
E. Cartão Chip/Tira Magnética 
F. Cartão Adesivo 

 The card type of 640DL-Amphi supports so far are: 
A. CR-80(A+B): Reserve two different templates for two CR-80 size cards. 
B. CR-80(A+A): Reserve one template for two CR-80 size cards. 
C. CR-90 
D. CR-100 
E. Full page 

 Amphi II supports：PVC Full Page (Border), Full Page (Borderless) 
 
  3) Seleção de lado 
     Frente, traseiro ou lado duplo  

       
 
  4) Orientação 
     Vertical ou horizontal  
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1.4 Barra de ferramente comumente usada 
    As opções de ferramenta incluem:  

Adicionar Texto Colorido 

Adicionar quadro de ID  

Adicionar imagem 

Importar fundo 

Importar código de barra 

Adicionar Texto em Negrito 

Adicionar Linha  

Adicionar Figura 

Adicionar quadro-e 

Abrir Arquivos “*.mds”  

 Add 2D Barcode 
 
1.5 Área de Inserção de Fotografia de ID 1.6 Arquivo de Camada 

  
 
1.7 Previsualizar & Editar áreas 
   Horizontal                            Vertical 
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Capítulo 2 Edição de Cartão 
 
2.1 Adicionar Texto Colorido     
 

Clique , uma camada de texto colorido será criado imediatamente na área de 

edição. Um usuário pode fazer os seguintes ajustes.  
 

Digite o texto: Um usuário pode digitar o conteúdo de texto nesta área.  

 
 

Alinhamento: superior-esquerdo, superior-central, superior-direito, central-  
           esquerdo, central-central, central-direito, inferior-esquerdo, inferior-  
           central, inferior-direito 

 
  
 Tipo de letra: tipo de letra, tamanho, intervalo, negrito, itálico, sublinhado, vertical,   
 direita para esquerda 

 
  Cor da Letra:                          Cor de Fundo: 

Configuração avançada de texto: 
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Desenho da palavra Sombreamento 

Texto Não Desenhado Não Sombreado 

Reto 1~6 Esquerdo-Superior 

Côncavo Esquerdo-Inferior 

Saliente Direito-Superior 

Cima-Arco 1,2 Direito-Inferior 

Baixo-Arco1,2 Direito 

Superior-Arco Superior 

Superior-Arco  

Encolhimento Interno  

Expansão  

Onda 1~6  

 
2.2 Adicionar quadro de ID 

1) Clique , para criar um quadro ID e clique  para escolher a origem para 
carregar imagens de ID.  

 
     

1. Loading images from files (Carregando imagens a partir de arquivos) :   
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  Carrega diretamente as imagens ID dos arquivos.  
2. Loading images from webcam (Carregando imagens a partir da webcam) : Carrega 

imagens ID capturadas por uma webcam. 

 Capture Device (Dispositivo de Captura) : A webcam que 
você está usando.  

 Filter (Filtro) : A configuração para uma webcam 
 Live Video Preview (Pré-visualização de Vídeo ao Vivo) : 

O vídeo ao vivo é mostrado nesta área.  
 Captured Bitmap (Bitmap Capturado) : A imagem 

capturada por uma webcam é mostrada nesta área.  
 Capture Directory (Diretório Capturado) : Seleciona o 

destino para salvar a imagem que você capturou.  
 Snap Still (Fotografar) : Clique para capturar a imagem 
 File Name (Nome do Arquivo) : O nome da imagem 

capturada por  uma webcam 
3.  Loading images from WIA (Carregando imagens a partir de WIA) (para   

   Windows  XP/ME) : Usando uma webcam para capturar uma imagem pelo   

   WIA. 

4.  Loading images from TWAIN (Carregando imagens a partir de TWAIN)   

   (para Win98/2000) : Usando uma webcam para capturar uma imagem pelo  

   TWAIN.  
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 Acquire (Adquirir): Clique Acquire (Adquirir) para selecionar um 

dispositivo a fim de conectar ao seu computador.  

 

 

 

 

Depois de selecionar um dispositivo, há quatro opções mostradas a 

seguir.  

               A:Capture (Capturar): Clique para  

                  capturar uma imagem.  

          B:Source (Fonte): Configuração 

                 de dispositivo. 

          C: Format (Formato):Configuração 

                 do formato das imagens.  

          D: Exit (Sair): Fechar esta seção. 

 

 

 Select (Selecionar) : Por favor selecione uma imagem que você 

capturou a partir de uma webcam e em seguida pressione o botão 

[Select], a imagem será carregada no quadro de ID.  

 
2) Ajuste a fotografia de ID pelo quadro vermelho para a área que você deseja 
focalizar.  
 
 
 
 
 
 
 
 
 
 

Ａ Ｂ Ｃ Ｄ
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3) Ajuste a orientação da fotografia de ID.   

4) Clique  para inserir a fotografia de ID no quadro de ID na área de edição 

depois de haver finalizado o ajuste de tamanho e o local da fotografia de ID.  
Contudo, se você não estiver conectado a um arquivo de banco de dados, salve o 
ajuste via Menu Bar→File→Save (Menu → Barra → Arquivo → Salvar).  Se 
você já conectou a um arquivo de bancio de dados, abra Print Info (Banco de Dados 
da Informação de Impressão) antes de você ajustar a fotografia de ID para salvar o 
ajuste para o Banco de Dados da Informação de Impressão automaticamente. Consulte 
à seção 4.4: Construção de um “banco de dados da informação de impressão” no 
Capítulo 4. 
 
5) Ajuste de Côr e Gerenciamento de Imagem  

1. Se você não estiver conectado a um arquivo de 
banco de dados,  após terminar o ajuste das 
propriedades de côr, registre o resultado pelo  
Menu Bar→File→ Save (Barra de Menu 
→Arquivo → Salvar). 
2. Se você já está conectado a um banco de dados, abra Print Info (Banco de dados 

da Informação de Impressão) antes de você ajustar as propriedades da côr. Após 
terminar o ajuste das propriedades de côr, pressione ＂Save post processing 
image” (Salvar imagem de processamento subsequente) em “Image 
Management” (Gerenciamento de Imagem) para salvar o resultado.  Você pode 
pressionar ＂ Reload original photo” (Recarregar fotografia original) para 
retornar e desfazer a mudança.  

 

 
Brilho/Contraste 

 
Matiz/Saturação 

 
Balanço de Côr 

 
Presentação MiraBella (escolha a sua favorita a partir dos 9 
tipos de presentação fina) 

 
Os botões ” Save post processing image” (Salvar imagem 
de processamento subsequente) e ” Reload original photo” 
(Recarregar fotografia original) em Image Management 
(Gerenciamento de Imagem) são disponíveis somente 
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depois de você haver conectado a um arquivo do banco de dados, abrido Print Info 
(Banco de Dados da Informação de Impressão), e ajustado as propriedades de côr.  
Contudo, o botão ” Confirm image existence” (Confirmar existência de imagem) é 
disponível depois de você haver conectado a um arquivo de banco de dados e abrido 
Print Info (Banco de Dados da Informação de Impressão.) 
 

 
Salvar imagem de processamento subsequente 

 
Recarregar fotografia original 

 Confirmar existência de imagem. Consulte a seguinte ※
descrição.  

 
※ Quando você clicar em “Confirm image 

   existence” (Confirmar existência de imagem), 

   o computador examinará as imagens e os dados 

   que você marcou em “Printing Information  

   database” (Banco de dados da Informação de  

   Impressão). Se uma imagem não existe no caminho, um quadro de diálogo é   

   mostrado como a que está na figura à  direita. Depois de você clicar “OK”, os   

   dados sem a imagem não estarão marcados em “Printing Information database”   

   (Banco de dados da Informação de Impressão).    

   Depois de você marcar  □Skip printing of all data without images (Saltar  

   impressão de todos os dados sem imagens), todos os dados sem quaisquer  

   imagens não serão marcados em “Printing Information database” (Banco de dados  

   da Informação de Impressão). 

Observação:※  Gerenciamento de imagem é disponível somente depois de conectar o 

arquivo de banco de dados e depois de iniciar “Printing Information database” (Banco 

de dados da Informação de Impressão) e imagens de processamento. Consulte à seção 

4.4: Como construir um “print information database” (Banco de dados da informação 

de impressão) no Capítulo 4. 

 
 Mudar formato da imagem : 
O formato do quadro da fotografia ID não está limitado a um quadrado regular. 
Clique sobre o botão e selecione seu formato favorito.   
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Você pode ajustar também o formato usando o cursor do mouse para arrastar os 8 
pontos ajustáveis.  

 
2.3 Importar fundo 

1) Clique  para exibir o quadro de diálogo da seleção de arquivo. Escolha 
uma imagem de fundo.   

 
2) Configurações de Propriedade 

 
Gire 90° no sentido anti-horário 

 
Gire 90° no sentido horário 

 
Gire 180° 

 
Espelho 

 
Ajustar a Largura  

 
Ajustar a Altura 

 
Ajustar ao Cartão 

 
Brilho/Contraste 

 
Matiz/Saturação 

 
Balanço de Cartão 

 
Configurações Avançadas 

 
　 Configurações Avançadas: Escolha um tipo de fita diferente para 

impressão. Usando fita K de negrito significa fazer uso da camada K da 
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fita YMCKO para imprimir o fundo em uma imagem preto e branco. Você 
pode ajustar também o resultado de impressão pela “Threshold bar” (Barra 
de Limite) e previsualizá-lo diretamente.  

 
 
2.4 Importar código de barra  

  Clique  para criar uma barra de código. 
Propriedades de ajuste: 
 

 Conteúdo 

 Formato 

 Mostrar Texto  

 Altura de Texto 

 Tipo de Letra do Texto 

 Prefixo 

 Ângulo 

 Transparência 

 
Usando fita diferente para 
imprimir 

 
2.5 Adicionar Texto em Negrito  

Clique  para criar uma camada de texto em negrito imediatamente na área de 
edição. O usuário pode fazer os seguintes ajustes: 
Digite o texto: O usuário pode entrar o texto nesta área.   
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Alinhamento: superior-esquerdo, superior-central, superior-direito, central-
esquerdo, central-central, central-direito, inferior-esquerdo, inferior-
central,  inferior-direito. 

 
 

Tipo de Letra: tipo de letra, tamanho, intervalo, negrito, itálico, sublinhar, vertical, 
direita para esquerda 

 
 Côr de Fundo: 

  
2.6 Adicionar Linha e Figura 

A. Adicionar Linha 

   Clique , uma linha diagonal aparecerá na área de edição. Clique  e 

pressione o botão esquerdo do mouse 

para exibir a lista de opção como 

mostrado.  

 

 B. Adicionar Figura    

   Clique eck e uma figura sólida aparecerá na área de edição. Clique           

e pressione o botão do mouse esquerdo para exibir a lista de opções como 

mostrado.  
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C. Ajuste de côr para Linha e Figura 

Você pode escolher a côr para Linha e Figura 

digitando números nos espaços em branco sob 

R/G/B，ou clique a tabela de côr. Também, você 

pode escolher uma largura diferente para Linha, 

Retângulo e Círculo que não estiverem 

preenchidos.  

 

2.7 Adicionar imagens 
 

Clique para adicionar uma imagem da fonte atribuída. A imagem adicionada 

não será definida como uma fotografia de ID, por isso as propriedades serão 
similares a um fundo. 
 

2.8 Abrir um arquivo “*.mds”  

Clique  para fazer aparecer o diálogo de seleção do arquivo de planilha.  
Escolha um arquivo de planilha existente que você usará. ("*.mds " é o formato de 
planilha de CardDésirée CS). A planilha que você abriu será mostrado 
imediatamente na área de edição para a sua edição.  
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Teclas de função com o botão 
direito do mouse  

Deletar 
Renomear 
Esconder(/Exibir) 
Bloquear/Desbloquear 
Cima 
Baixo 
Empurrar camada para 
cima 
Empurrar camada para 
baixo  

 

2.9 Add 2D Barcode 

Click  to add 2D Barcode : 

Select 2D barcode type 

Insert the data for encoding 

Decide the resolution by the horizontal and vertical intervals

Insert Parameters: Numbers of Rows / Columns and ECC 

Level (ECC Level: Error Correction Control Level : The 
bigger index you select, the higher readability you get 
when 2D barcode is damaged; meanwhile, the more 
space the file needs.) 
By selecting this option, the right hand side of the 
barcode will be removed or " truncated". It can keep 
more efficient area than unchecked PDF417. 

 

Select the type of the ribbon to print this 2D barcode 

 
2.10 Arquivo de Camada 
 

1) Todas as camadas são mostradas no arquivo (Eles podem incluir Texto 
Colorido, Texto em Negrito, Fundo, Código de Barra e talvez uma fotografia 
com quadro ID), você pode focalizar uma delas e clicar no botão direito do 
mouse para ajustá-la : 
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2) Na área de edição, você pode focalizar a camada clicando no botão do mouse. Se 
houver uma camada focalizada, então o menu abaixo aparecerá:  

 
 
 
 
 
 
 
 
 
 
   ou mostrará as seguintes opções: 
  

 
 
 
 
 
 
 

2.11 Impressão de cartão  

Depois de terminar a edição, clique  para imprimir os cartões.  

 
 

Teclas de função com o botão direito 
do mouse:  

Cortar (Ctrl+’X’) 
Copiar (Ctrl+’C’) 
Duplicar (Ctrl+’L’) 
Colar (Ctrl+’V’) 
Colar (Ctrl+’V’) 
Deletar(Del) 
Empurrar camada 
para cima  
Empurrar camada 
para baixo 
Trazer para Frente  
Enviar para Trás  

 Teclas de função com o botão direito 
do mouse : 

Réguas 
Linhas Entrecruzadas 
Colar (Ctrl+’V’) 
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A: Selecionar impressora: Hiti CS-300/310/320, 640DL-Amphi ou Amphi II para as 
suas opções. 
B: Opções de fita: YMCKO, Negrito K ou fitaYMCO para as suas opções. 
C: Lamination: This function is available for lamination module only. There are 

four options: No Lamination, Front Side, Back Side, Dual Side. 
D: Configuração de Impressão: Imprimir trabalho actual ou trabalho selecionado.  
E: Configuração de Rotação: Você pode girar a imagem a 180 graus durante a impressão.  
F: A limitação de impressões na fila de impressão: De 3 a 10 e trabalhos   
  ilimitados  
G: Desmarcar a coluna “Print?” (Imprimir) depois do envio de trabalhos de  
   impressão para a fila de impressão. 
H: Operation: four operation function available for your options: Print, Magnetic Encode, 
Contact Smart Card Encode, Contactless Card Encode. 
I: Tremor em negrito: Usando um algoritmo para transferir a imagem colorida  
   para preto e branco. 
J: Número de cópias & Número total de impressões. 
K: Durante impressão, você pode clicar “Cancel” (Cancelar) para parar a impressão.  
 

Observação※ : 
1.Quando você clica o botão “Cancel” (Cancelar), o trabalho de impressão que já foi 

enviado para o spool de impressão AINDA será imprimido.  
2.Contudo, quando você clica no botão “Cancel” (Cancelar), o trabalho de  
   impressão que NÃO há sido enviado ao spool de impressão será cancelado.  

 

 A B

 C 

 D 

 E 

 F 

 G 

 H 

 I 

 J 
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Capítulo 3 Funções de Codificação 
 

3.1 Função de Codificação do Cartão Inteligente de Contacto 
Você pode aplicar funções de codificação a um cartão de Chip Inteligente de  
6-pin, um cartão Inteligente de 8-pin, e um Cartão Magnético de Chip. Depois 
de você selecionar “Contact Smart Card” (Cartão Inteligente de Contacto), 
haverá um espaço em branco na área de edição no lado de frente mostrado 
como se segue.  

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 

3 

4 
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1. Command Line (Linha de Comando):  O caminho para o arquivo 
iniciar a função de codificação 

2. Arguments (Argumentos): Parâmetros para codificação. 
3. Data to Encode (Dados para Codificar): Fonte de Dados para 

codificação. Você pode entrar os dados de codificação diretamente. Ou 
você pode selecionar Counter Source (Contador de Fonte), Date/Time 
Source (Data/Horário de Fonte), Concatenation Source (Fonte de 
Concatenação) ou ODBC Source (Fonte ODBC) como sua fonte de 
dados. Consulte o Capítulo 4 para os detalhes da configuração de 
propriedades.  
□ inserir Caracter de Aspas: Você pode entrar as aspas uma vez 

que você marque este item.  
  
        4. Opções para Impressão Contínua:  

 Confirmar antes da impressão. 
 Marque o arquivo antes da impressão (“Yes” (Sim) para 

imprimir): Depois de marcar o arquivo, cartões inteligentes de 
contacto defeituosos não serão imprimidos e somente cartões 
inteligentes de contacto perfeitos serão impressos.  

 

3.2 Função de Codificação de Cartão Magnético  

Seleciona “Magnetic” (Magnético) para entrar os Dados de Codificação 
Magnética.  
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Seleciona as pistas que você deseja  

codificar e decide a fonte de dados:  

 Nenhum Mapeamento: Entrar dados  

diretamente; 

 Counter Source (Contador de Fonte),  

Date/Time Source (Data/Horário de Fonte), Concatenation Source (Fonte de 

Concatenação) ou ODBC Source (Fonte ODBC) como sua fonte de dado.  

Consulte o Capítulo 4 para obter detalhes da configuração de propriedades.  

 

3.3 Função de Codificação do Cartão Magnético de Chip 

Rever 3.1 e 3.2 para codificação de Chip e codificação Magnética respectivamente 
para um Cartão Magnético de Chip.  
 

 
 
 



____________________________________________________________________  
              

www.hi-ti.com -25-

Capítulo 4 Banco de Dados 
 
4.1 Introdução da Função de Banco de Dados : 
 

Esta função é para ajudar-lhe a conectar os dados variáveis, que estão colocados 
em uma planilha do seu próprio design, com o banco de dados de meta para 
executar impressão em lotes. Depois de você construir um banco de dados, você 
pode conectar os componentes na planilha, tais como a fotografia de ID, o 
conteúdo de texto, o código de barra, e até mesmo a imagem de fundo com dados 
em colunas diferentes do banco de dados através da função “Database” (Banco 
de Dados) em CardDésirée CS. 
Quando você clica no ícone “print” (imprimir), HiTi CS-300 imprimirá 
automaticamente os dados item por item.  

Observaç※ ão：ODBC é a interface de conexão entre CardDésirée CS e o 
arquivo de banco de dados mas ODBC não suporta Unicode. Por isso, alguns 
caracteres podem não serem exibidos ao conectar o arquivo do banco de dados 
através do ODBC mesmo se você editar seu arquivo de banco de dados com 
Unicode. 
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4.2 Como conectar a um arquivo de banco de dados existente ?  
 

 Abrir a planilha  
1. Executar [CardDésirée CS] 

 
 
 
2. Consultar o segundo capítulo para fazer uma planilha. Se você já tem uma 

planilha, então abra-a por [file] → [open] (arquivo → abrir). 

       

 
 
3. Depois de você carregar a planilha, você pode iniciar conectando-a ao banco 

de dados.  
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 Conectar a um banco de dados pela primeira vez  
 
Um usuário pode usar Access (*.mdb) ou Excel (*.xls) para editar um arquivo como 
um banco de dados respectivamente. O exemplo seguinte mostrará como salvar um 
arquivo excel como um banco de dados.  
 

1. Depois de entrar todos os dados, bloqueie todos os conteúdos que você 
precisará em uma tabela:  

 

 
 

    2. Selecione Insert → Name → Define (Inserir → Nome → Definir) para 
definir o nome da tabela mostrada como se segue.  
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3. Entre o nome desta tabela e pressione “OK”. O nome desta tabela estará na  
     lista para sua opção durante o processo quando você conecta o banco de   
     dados.  

 

 
     4. Salve este arquivo antes de fechar Excel. 

 
Depois de completar o procedimento acima, siga este processo para conectar o banco 
de dados mostrado como se segue.  
 

1. Clique [Database] (Banco de Dados) na barra de ferramenta e escolha 
[Connect Database] (Conectar Banco de Dados).  
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2. Se você não há construído uma fonte de dados, clique no botão [Add] 
(Adicionar) depois de você entrar [ODBC Administrator] (Administrador 
ODBC) para estabelecer uma fonte de dados.  

       
 
3. Selecione um controlador para a fonte de dados. (Deve ser um arquivo 

*.mdb ou *.xls em geral). Em seguida pressione Finish (Finalizar). 

 

4. Entrar um nome e descrição para a fonte de dados, e em seguida pressione  
Select (Selecionar). 
Testado por um arquivo Access:      Testado por um arquivo Excel:                    
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5. Procurar e selecionar um banco de dados, e em seguida pressione OK. 
Testado por um arquivo Access:      Testado por um arquivo Excel: 

  
 
6. A fonte de dados que você acabou de adicionar será mostrado na lista.  

Testado por um arquivo Access:       Testado por um arquivo Excel: 

   
7. Depois de clicar em [OK], ele retornará ao quadro de diálogo “Available 

Data Sources” (Fontes de Dados Disponíveis), clique em [Refresh] 
(Atualizar) e a fonte de dados recém-adicionados aparecerá na lista.  
Testado por um arquivo Access:       Testado por um arquivo Excel: 
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8. Selecione a fonte de dados de meta e clique em [Next] (Seguinte). 
Testado por arquivo Access:           Testado por um arquivo Excel: 

   
 

9. Selecione uma tabela de meta. Quando você tem mais de uma tabela em um 
arquivo de banco de dados, você pode atribuir o arquivo meta neste quadro 
de diálogo, e em seguida clicar em [Finish] (Finalizar). 
Testado por um arquivo Access:        Testado por um arquivo Excel: 

    

 
10. Depois de completado a conexão, [Record] & [Record list] (Registro & 

Lista de Registros) em [Database] (Banco de Dados) será activado. 
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 Desconecte o Banco de Dados. 
 Registro:  Procurar cada dado. 
 Lista de Registros: Revisar a lista de dados. Observação※ . 
 Mapeamento de Camada: Para atribuir as camadas na planilha com o banco 

de dados.  
Observação※ ：Consulte à Seção 4.4: Como construir um “banco de dados da    

             informação de impressão” em Capítulo 4.  
 
Também, consulte às seguintes seções para informação com relação à função 
[Record] (Registro), [Record list] (Lista de Registros), e [Layer Mapping] 
(Mapeamento de Camada).  
 
11. Depois de completar as configurações, lembre-se de salvar o arquivo. O 

mapeamento de camada será guardado no arquivo “*.mds” e permanecerá 
disponível quando você abrir a planilha da próxima vez.  
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 Como executar “Layer Mapping” (Mapeamento de Camada)? 
1. Depois de escolher [Layer Mapping] (Mapeamento de Camada), o nome da 

camada e seu estado de mapeamento será mostrado no diálogo de dados de 
fonte. Se você não fez nenhuma configuração, ela mostrará  “No Mapping” 
(Nenhum Mapeamento) na coluna “Source” (Fonte). 

 

 

 
2. Escolher a Camada de meta. Se você escolher a camada ID ou a camada de 

Fundo, então haverá seis tipos diferentes de fontes mostradas na lista 
pendente.  
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 Nenhum mapeamento: Não precisa configurar nenhuma fonte para a 

camada de meta.  
 Fonte de Evento: Para atribuir uma fonte de evento para a camada. 

Precisa usar com o software HiTi Event Desiree.  Por favor contacte 
HiTi FAE. 

 Fonte de Webcam: Para atribuir uma fonte de webcam para a camada.  
 Fonte WIA : Para atribuir uma fonte WIA para a camada. 
 Fonte TWAIN: Para atribuir uma fonte TWAIN para a camada. 
 Fonte ODBC: Para atribuir uma fonte ODBC para a camada.  

 
Se você escolher a camada de texto ou código de barra, haverão cinco tipos 
diferentes de fontes mostradas na lista pendente.  
 

 
 Contador de Fonte: Para atribuir um contador de fonte para a camada.  
 Data/Horário da Fonte: Para atribuir uma data ou horário de fonte para 

a camada. 
 Fonte de Concatenação: Para atribuir uma fonte de concatenação para a 

camada. 
 Fonte ODBC: Para atribuir uma fonte ODBC para a camada.  
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3. Depois de terminar as configurações da fonte de dados, pressione [Apply] 
(Aplicar). 

 

 
 

4. Depois de configurar todas as camadas, a coluna de fonte mostrará todos os 
resultados. Pressione o botão [OK] para completar o mapeamento de camada.  
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 Introdução das propriedades da fonte de dados.  
  1. Contador de Fonte 
    Função: Para atribuir um contador de fonte para a camada.  

 
 
 
 
 
 
 

2. Data/Horário da Fonte 
    Função: Atribuir uma data/horário   
    de fonte para a camada.  

 
 

1 
2 

3 
4 

5 

6 

1. Previsualização:  Para previsualizar o 
resultado.  

2. No. de dígitos fixos: Para configurar os 
dígitos de números para o contador.  

3. Mantenha o zero adiante.  
4. Valor inicial: Para configurar o valor 

inicial.  
5. Incrementar por: Para configurar o 

incremento. 
6. Pressionar [Apply] (Aplicar) depois de 

finalizar as configurações.  
Ex: Entrada 3 no “No. of fixed digits” (No. 
de dígitos fixos), marque a caixa  “Keep 
zero ahead” (Manter zero adiante), entrada 
5 como o valor inicial,  2 como o 
incremento, e em seguida uma série de 
números como 005, 007, 009, 011… serão 
mostrados na seção de previsualização.  

1. Preview (Previsualização): Para 
previsualizar o resultado.  

2. Date Source (Data da Fonte). 
3. Time Source (Horário da Fonte) 
4. Style (Estilo): Para ajustar tipo de 

visualização da data/horário.   
5. Separator (Separador): Para configurar 

a separação.  
6. Keep zero ahead (Manter o zero 

adiante). 
7. Pressione [Apply] (Aplicar) depois de 

terminar a configuração. 
Ex: marque a data de fonte, escolha  “mm 
dd yyyy” (mm dd aa) como visualização de 
fonte, ”/” como a separação, marque a 
caixa “Keep zero ahead”( Manter zero 
adiante), e se a data do sistema for 
2006.2.22, a previsualização mostrará 
como 02/22/2006。 

1 

2 

3 
4 

5 

7 

6 
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3. Fonte de Concatenação 
    Função: Atribuir data/horário de fonte para a camada. 

 
 
 
 
4. Fonte ODBC  
  Função: Para atribuir uma fonte ODBC para a camada. 

 
 
 
 
 
 
 

1. Preview (Previsualização): Para 
previsualizar o resultado. 

2. Prefix (Prefixo): Para configurar os 
dígitos precedentes fixos.  

3. Source 1 (Fonte 1): Escolha contador 
ou data ou horário ou concatenação 
como primeira fonte.  

4. Separator (Separador): Para configurar 
a separação.  

5. Source 2 (Fonte 2): Escolha contador 
ou data ou horário ou concatenação 
como primeira fonte.  

6. Suffix (Sufixo): Para configurar os 
dígitos subsequentes fixos.  

7. Properties (Propriedades): Para 
configurar as propriedades da fonte de 
dados .  

1 

2 

3 

4 

5 

6 
7 

1. Preview (Previsualização): Para 
previsualizar o resultado.  

2. Prefix (Prefixo): Para configurar os 
dígitos precedentes fixos.  

3. Select a column (Selecionar uma 
coluna): Para apontar para uma certa 
coluna no banco de dados. A lista 
pendente incluirá todas as colunas 
internas.   

4. Suffix (Sufixo): Para configurar os 
dígitos subsequentes fixos.  

1 
2 

3 

4 
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 Para ligar uma camada ao banco de dados: Uma vez que você selecione  Fonte 

de Webcam, Fonte WIA, ou Fonte TWAIN como sua fonte de imagem ID, um 
diálogo aparecerá para lhe pedir que capture as imagens de seu dispositivo 
durante a impressão. Consulte o Capítulo 2 seção 2.2 para maiores detalhes.  
 
Contudo, se você selecionar ODBC como sua fonte de imagem ID, siga a 
instrução como se segue.  
 
Primeiro, você precisa salvar todos os arquivos de imagens que você deseja em 
uma mesma pasta, e digitar todos os nomes de arquivo sequencialmente em uma 
certa coluna do banco de dados. Por exemplo, você pode colocar todos os 
arquivos de imagem em uma sub-pasta “PM” que está na pasta “CStest” no disco 
D, e também digitar todos os nomes do arquivo imagem em uma coluna chamada  
“Photofield” em seu banco de dados.  Enter “D:\CStest\PM\” no espaço em 
branco de [Prefix] (Prefixo) e entre “.jpg” no espaço em branco de [Suffix] 
(Sufixo). Em seguida, escolha “Photofield” na lista pendente [Select a column] 
(Selecionar uma coluna),  pressione o botão [Apply] (Aplicar) para finalizar as 
configurações.  
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4.3 Como procurar / inquirir certos dados em seu banco de dados ?  
 

Primeiro, você precisa abrir uma planilha e conectar ao banco de dados. Faça 
isso através de [File] → [Open] (Arquivo → Abrir) para abrir uma planilha.  

       
 

Em seguida, você pode previsualizar certos dados com os botões [Record list] 
(Lista de Registros) ou usando os botões no menu principal.  

 
 
 

 Procurar por [Record list] (Lista de Registros) 
 
1. Depois de você clicar em [Record list] (Lista de Registros), a lista de dados 

aparecerá. Todas as colunas internas (o lado direito) serão as que forem 
atribuídas a uma certa camada. Outras colunas estarão invisíveis 
automaticamente. Arraste os limites para revelar as colunas invisíveis. A 
coluna bloqueada no lado esquerdo exibe “Print Information” (Informação 
de Impressão). 
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2. Clique no botão [Search] (Procurar), e o diálogo de procura aparecerá. 

 
 

 Select a field to search (Selecionar um campo de procura): escolha a 
coluna de meta que você deseja procurar.  

 Search Data (Procurar Dados): Entre a condição da procura.  
 Match whole word only (Corresponder somente com a palavra inteira): 

A procura deverá corresponder com a palavra exata digitada no espaço 
em branco de “Search data” (Procurar dados). 

 Match case (Corresponder com as maiúsculas e minúsculas):  A 
procura agora é sensível a maiúsculas e minúsculas.  

 Check the selected data (Marcar os dados selecionados): O quadro de 
marcação dos dados encontrados que você procurou serão marcados. 
Esta função é para a conveniência da impressão de dados específicos.  

 
3. Se mais de um dado for encontrado, pressione [Next] (Seguinte) para 

mostrar o dado adicional.   
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 No canto superior esquerdo do quadro de diálogo de procura, exibirá a 
posição dos dados de meta no banco de dados.  

 mostra que os dados de meta é o quarto entre o total de 
dezesseis entradas de dados.  

 Os dados de meta encontrados serão sublinhados com uma côr 
diferente na lista de dados.  

 
 

 Inquerir por [Record list] (Lista de Registros) 
 

1) Depois de clicar em [Record list] (Lista de Registros), a lista de dados 
aparecerá. Pressione o botão [Query] (Inquerir), e um diálogo [Query] 
(Inquerir) aparecerá. Use ＂＞＂，＂＜＂，＂＝＂，＂None＂
(Nenhum)，＂And＂(E) e＂Or＂(Ou) como suas condições de 
inquerimento.  
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Depois de entrar estas condições e pressionar [OK], a lista de dados exibirá os 
resultados mostrados como se segue: Dados (1/3) mostra que o total de 3 dados  
correspondem com as suas condições e o dado de meta é a primeira entrada.   
 

 
 
 
 
 
 
 
 
 
 
 

※ Você pode manter as últimas condições para o [Query] (Inquerir) de modo que ao 
abrir esta planilha da próxima vez, você possa obter diretamente os resultados de 
[Query] (Inquerir) do banco de dados através destas condições anteriormente 
entradas. Por favor siga estes passos: Menu Bar→ File → (Barra de Menu 
→Arquivo). Pressione [Save] (Salvar), um quadro de diálogo aparecerá：”Do you 
want to save the query condition to file?” (Deseja salvar a condição de 
inquerimento para o arquivo?), ele mostra as últimas condições que você entrou 
para sua referência, por exemplo:  Dep =”sales” (Dep = vendas).  Você pode 
pressionar [Yes] (Sim) para salvar estas condições. 

 
 
 

 
 
 
 
 
 
 
Quando você abrir esta planilha da próxima vez, um diálogo aparecerá para lembrar-
lhe qual condição [Query] (Inquerir) há sido salvada com esta planilha, por exemplo,  
Dep=”sales” (Dep = vendas).   
Depois de abrir esta planilha, os dados mostrados na Lista de Dados são os resultados 
inqueridos através destas condições que você salvou da última vez.   
Se você precisar de todos os dados originais, simplesmente pressione [Query] 
(Inquerir) para deixar a condição em branco e em seguida pressione [OK]. 
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 Previsualize e inquira usando a barra de ferramenta do menu principal 
 

 
 

 
 

1. Opção de Pré-visualização: Desmarque a bandeira, você pode 
previsualizar todos os dados no banco de dados “Printing Information” 
(Informação de Impressão); contudo, depois de marcar a bandeira, 
você poderá somente previsualizar os dados que você marcou no banco 
de dados “Printing Information” (Informação de Impressão). 

2. Previsualizar o primeiro dado 
3. Previsualizar o dado anterior 
4. Previsualizar o próximo dado 
5. Previsualizar o último dado 
6. Procurar (O mesmo que “Search by [Record list]” (Procurar por (Lista 

de Registro)) 
 

 Pré-visualização de impressão de certos dados  
 

1. Clique na [Record list] (Lista de Registro). Ao escolher os dados de 
meta a partir de “Data List” (Lista de Dados), você verá a pré-
visualização desses dados no menu principal. Pressione o botão “Print” 
(Imprimir) para imprimir. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
2. Quando o quadro de diálogo “Print” (Imprimir) aparecer, marque 

[Current Job] (Trabalho Actual) para imprimir os dados que você está 
previsualizando.  

 
 
 
 
 
 
 
 

1 2 3 4 5 6 
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4.4 Construa um banco de dados “Printing Information” (Informação de 
Impressão) 

 
 O que é um “Print Information Database” (Banco de Dados da Informação de 

Impressão) ? 
Depois que um usuário processa imagens ID, estes parâmetros de 
configuração, tais como propriedades de tamanho, lugar e côr, serão 
adicionados em “Print Information” (Informação de Impressão). Além disso,  
“Print Information” (Informação de Impressão) exibe os dados a serem 
impressos; quantidades de impressos de cada dado e quando os dados serão 
impressos. Por isso, o “Print Information” (Informação de Impressão) revela 
a seguinte informação para cada dado:  
 
1. Print (Imprimir)? : Imprime ou não? 
2. Printed (Impresso): Quantidades impressas 
3. Print_Time (Horário de Impressão): O último horário de impressão dos  
  dados.  

       4. Total_Prints (Total de Impressões): As quantidades totais de impressão    
 de cada dado.  

 
 Construir um “Print Information Database” (Banco de Dados da Informação 

de Impressão)  
 
1. Abrir Data List (Lista de Dados) através de Record List (Lista de 
  Registro) 
 

 
 

 
 Depois de conectar a um banco de dados e ※ ao mapeamento de camada, a 

Lista de Dados aparecerá pela Record List (Lista de Registros).  A 
exibição de cada mapeamento de camada corresponde ao banco de dados 
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original que você editou será mostrado no lado direito. Outras colunas se 
esconderão automaticamente e aparecerão somente quando o cursor de 
mouse for arrastado sobre elas. Print Information (Informação de Impressão) 
será exibida na esquerda incluindo Print (Imprimir)?, Printed (Impresso), 
Printed_Time (Horário de Impressão), Total_Prints (Total de Impressos). A 
área em côr cinza na esquerda indica que Print Information Database (Banco 
de Dados da Informação de Impressão) não há sido criado ou aberto. Antes 
de você abrir o Print Information Database (Banco de Dados da Informação 
de Impressão), todos os ajustes para a fotografia de ID incluindo 
propriedades de tamanho, lugar e côr não poderão ser registrados.  

 
Se você há criado um Print Information Database (Banco de Dados da 
Informação de Impressão), pressione [Print Info] (Informação de Impressão) 
para abrir seu Print Information Database (Banco de Dados da Informação de 
Impressão). Consulte à próxima seção: Conexão / Abertura do Banco de 
Dados da Informação de Impressão neste capítulo). Se não, consulte aos 
seguintes passos para criar um Print Information Database (Banco de Dados 
da Informação de Impressão) e em seguida você poderá salvar os ajustes 
incluindo as propriedades de tamanho, lugar, e côr para a fotografia ID 
através de Print Database Information (Banco de Dados da Informação de 
Impressão). 

 
2. Pressione [Print Info](Informação de Impressão) para construir um 

“Print Information Database” (Banco de Dados da Informação de   
Impressão). Em seguida um quadro de diálogo aparecerá. Se você nunca  
construiu um banco de dados de  “Print Information” (Informação de  
Impressão), entre um nome de arquivo para construir seu primeiro “Print  
Information Database” (Banco de Dados da Informação de Impressão), e  
em seguida pressione “Open” (Abrir). 

 

         
 
※Observação: Não Abra seu banco de dados original, ele não é o seu  
“Print Information Database” (Banco de Dados da Informação de 
Impressão), preste atenção a ele.  
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        3.  Antes de você construir o primeiro “Print Information Database” 
(Banco de Dados da Informação de Impressão), este arquivo “Print 
Information Database” (Banco de Dados da Informação de Impressão) 
não existirá em sua pasta. Por isso enquanto você estiver construindo o 
primeiro “Print Information Database” (Banco de Dados da Informação 
de Impressão), um quadro de diálogo aparecerá para lembrar-lhe e 
pedir-lhe se você deseja criar este arquivo ou não. Clique “OK” para 
continuar a construir o “Print Information Database” (Banco de Dados 
da Informação de Impressão).  

 

 
 
 

     4. O sistema de computador lhe pedirá para selecionar um campo como 
chave de índice para conectar ao banco de dados original. Selecione um 
campo envolvendo dados diferentes sem repeti-lo como uma chave de 
índice. 

 
 

 
 
 
      5. Em seguida haverá uma advertência explicando “The field can be 

annulated” (O campo pode ser anulado), pressione “OK” para 
completar a construção de “Print Information Database” (Banco de 
Dados da Informação de Impressão).  

 
 

 
 
 
Depois de completar este processo, a Data List (Lista de Dados) exibirá a seguinte 
informação:  
O lado esquerdo exibirá “Print Information Database” (Banco de Dados da 
Informação de Impressão) e estará iluminado. A côr iluminada significa que “Print 
Information Database” (Banco de Dados da Informação de Impressão) está aberto. 
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Também, todos os dados serão selecionados quando um novo “Print Information 
Database” (Banco de Dados da Informação de Impressão) houver sido criado pela 
primeira vez. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
[Descrição]： 

1. Print (Imprimir)? : Você pode selecionar que dado você está interessado 
   em imprimir ou previsualizar.  
2. Printed (Impresso): Quantidades impressas para cada dado.   

      3. Print_Time (Horário de Impressão): O último horário de impressão de   
        cada dado.  

4. Total_Prints (Total de Impressos): As quantidades totais de impressos de   
  cada dado.  
5. Select All (Selecionar Tudo): Você pode usar esta função para marcar ou   
  desmarcar todos os dados.  
6. Disable (Desactivar): Fecha o banco de dados “Print Information Database” 
  (Banco de Dados da Informação de Impressão). 

   7. Print Job Control (Controle da Tarefa de Impressão): Inclui configurações   
     Marcar/Desmarcar e Apagar o registro.   
 

 Print Job Control (Controle da Tarefa de Impressão):  
1. Check/Uncheck settings (Configurações para Marcar / Desmarcar): Você 

pode configurar as regras para cada coluna para decidir que dado deverá 
ser marcado ou desmarcado.  
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2. Clear record (Apagar registro): Você pode reajustar a coluna “Printed” 
(Impresso) ou “Print_Time” (Horário de Impressão). 

 
 Conexão / Abertura de “Print Information Database” (Banco de Dados da 

Informação de Impressão):  Depois de você criar um “Print Information 

Database” (Banco de Dados da Informação de Impressão), este banco de 

dados será salvado em seu computador. Abra um “Print Information 

Database” (Banco de Dados da Informação de Impressão) usando os 

seguintes procedimentos.  

 

3. Selecione Database→ Record list (Banco de Dados → Lista de Registro) 

para abrir uma lista de banco de dados.  

   
 

2. Use [Print Info](Informação de Impressão) para abrir o “Print Information 

Database” (Banco de Dados da Informação de Impressão). 
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3.  Selecione o “Print Information Database” (Banco de Dados da Informação 

de Impressão) que você há criado e pressione [Open] (Abrir) e em seguida o 

“Print Information Database” (Banco de Dados da Informação de Impressão)  

 se abrirá.  
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4.5About “Append Print Info.” Function 
 

 What is “Append Print Info.”? 

Compared with an independent “Print Information Database” 
mentioned above, to “Append print info.” means to append the 
print information to the users own database. In other words, this 
function combined the users’ database and print information into 
one *.mdb file rather than save the print information as another 
*.mdb file.  Users who used to save the database on their server 
would prefer to save the print information like this way. 

 
 How to “append print info.”? 

1. First,  you have to create some specific columns and set their 
properties in your database file. Please refer to the following 
table as the guide to create and do the settings. 

Column name Type Size Initial  Value 

HiTi_Print  Boolean(Y/N) --  --  

HiTi_Print_Count  Long integer --  0 

HiTi_Print_Time Date/Time --  --  

HiTi_Total_Print  Long integer --  0 

HiTi_ID1_Rect Text(varchar)  255 --  

HiTi_ID2_Rect Text(varchar)  255 --  

HiTi_ID1_Image OLE object --  --  

HiTi_ID2_Image OLE object --  --  

             Remark: “—“ means no need to set .  

 

2. Execute CardDesiree CS, open the template and connect with 
the database. Click “Append Print Info.” button in the page of 
“Data list”. Then the “print info.” will  be enabled as below. 
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3. After you activate the “Append Print Info.” function, the 
“Pint Info.” function which is at  the left down side of the 
same page would be disabled. That means you either could 
choose to append the print information to the same database 
or save as another database file. 

 
 

4. If you don’t create the specific columns before clicking the 
“Append Print Info.” button, there will  be an error message 
pup out as below. 
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4.6Dynamic Mode 
 What is Dynamic Mode? 

For the ease of instant card issuing cases, “Dynamic Mode” 
provides users to add new records into the database and preview 
the layout in the same window page simultaneously. Users could 
type the information in the established columns and save into the 
database. In the scenarios like conferences, exhibitions or the 
counter of coffee shops, it  could facilitate the attendants issuing a 
membership card easily and quickly. 

 

 How to use it? 

1. Please select “Database”→ “Dynamic Mode” in the main page 
of CardDesiree CS to open the operation window. 

 
2. Input the data into the established columns. Remember to 

click on “Update” to save. 

 
 New: Build a new record. 

 Update: Save the update information into the database. 

 Refresh: If there are more than two clients accessing to 
the same database, click on “Refresh” to make other 
clients could see the updates. 

 First/Last/Next/Previous: Function buttons for preview. 

 Close: Close this operation window. 
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Barra de Menu Previsualizar Imagens 

Barra de 
Ferramentasa 

Região de Edição 

Capítulo 5 Interface DBMaker  
 

 
5.1 Interface Principal  

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
5.2 Barra de Menu  

 
                             

 
1) Arquivo  
 
A opção do menu “File” (Arquivo) inclui:                                                  

New (Novo) (cria um novo arquivo de banco de dados) ) 

Open (Abrir) (abre um arquivo de banco de dados 

existente)  

Close (Fechar) (fecha um arquivo de banco de dados) 

Save (Salvar) (salva um arquivo de banco de dados) 

Save As (Salvar Como) (salva como um novo arquivo de 

banco de dados) 

Exit (Sair) (Sair do DBMaker) 
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2) Edit (Editar)： 

O menu “Edit” (Editar) inclui:  

Cut (Cortar) 

Copy (Copiar) 

  Paste (Colar) 

  Find (Encontrar) 

  * Para a função “Find” (Encontrar), entre os caracteres no espaço em branco de  

[Find what] (Encontrar o que), selecione o Field (Campo) e decida a  

Direction – Up ou Down (Direção – Cima ou Baixo) para sua procura. Você 

pode marcar também  □Match whole field (Corresponder ao campo inteiro) 

para procurar os caracteres correspondentes.  

 

 

 

 

 

 

 

 

 

 

 

3) Field (Campo) 

  O menu “Field” (Campo) inclui：  

Descend (Descendente) 

Ascend (Ascendente) 

Modify Field (Modificar Campo) 

 

 4) Record (Registro) 

   O menu “Record” (Registro) inclui： 

Add Record (Adicionar Registro) 

Delete Record (Deletar Registro) 
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5) Window (Janela) 

   O menu “Window” (Janela) inclui： 

 Cascade (Cascata) (Mostrando mais de uma 
tabela por formato de sobreposição como se 
segue.)  

 

 

            

 

 

 

 

 

 Tile (Mosaico) (Mostrando mais de uma tabela ao mesmo tempo como 

se segue.)  

 

 

 

 

 

 

 

 

 

6) Help (Ajudar) 

  O menu “Help” (Ajudar) inclui： 

        Arquivo “Help＂(Ajudar) & “About DBMaker” (Sobre DBMaker)  
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5.3 Barra de Ferramenta  

    

 

 

   1) Cria um novo arquivo de banco de dados 

   2) Abre um arquivo de banco de dados existente  

   3) Cortar 

   4) Copiar 

   5) Colar 

   6) Ajudar 
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         Capítulo 6 Editar o Banco de Dados por DBMaker 

 

6.1 Criar um Novo Arquivo de Banco de Dados 

    1) Menu Bar File New (Barra de Menu  Arquivo  Novo), ou pressionar  

 na Barra de Ferramentas. Em seguida pressionar [Browse] (Procurar). 

 

 

 

     

 

 

 

 

    2) Entrar o nome do novo arquivo de banco de dados, e pressionar [Save] (Salvar) 

para criar um novo arquivo de banco de dados. (Observação：Se você entrar um 

nome de arquivo existente ou selecionar um arquivo de banco de dados existente, o 

conteúdo original neste arquivo existente será substituído.) 

 

 

 

 

 

 

 

 

    3) O diálogo mostra o caminho do novo banco de dados. Pressione [Next] 

(Seguinte). 
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  4) Entrar o nome da nova tabela. 

 

 

 

 

 

 

 

5) Agora você pode selecionar  A. Auto Create Based on Existing Template (Criar 

Automaticamente Baseado na Planilha Existente) ou B. manual Creat (Criação 

manual). 

 

 

 

 

 

 

 

 

A. Auto Create Based on Existing Template (Criar Automaticamente Baseado 

na Planilha Existente)   

Significa que DBMaker criará um novo banco de dados com campos que 

serão baseados nas camadas de uma planilha existente *.mds que você criou 

no software – CardDesiree CS. (Observação：*.mds é um formato da 

planilha CardDesiree CS.) 

 

Se você selecionar A. Auto Create Based on Existing Template (Criar 

Automaticamente Baseado na Planilha Existente) e pressionar [Next] 

(Seguinte), siga os procedimentos indicados aqui embaixo. 

 

 

 

 

A 
B 
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1. Pressionar [Browse] (Procurar) para o Caminho da Planilha. 

 

 

 

 

 

 

 

 

 

 

2. Selecionar uma planilha *.mds e pressionar [Open] (Abrir). 

 

 

 

 

 

 

 

 

 

 

3. Pressionar [Finish] (Finalizar) 
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4. O campos deste novo arquivo de banco de dados será baseado nas camadas da 

planilha que você selecionou.  
As camadas da planilha em CardDesiree CS    Os campos do novo arquivo de banco de dados 

 

 

 

 

 

 

 

 

5. Entrar seus dados nesta tabela. O processo está completado.  

 

B. Manual Creat (Criação Manual) 

1. Se você selecionar [Manual Creat] (Criação Manual) o seguinte quadro de 

diálogo aparecerá. Pressione [New] (Novo) para criar os campos necessários.  

 

 

 

 

 

 

 

 

2. Entrar o Field Name (Nome de Campo) e pressionar [OK].  
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3. Depois de configurar os nomes de todos os campos necessários, pressione [Finish] 

(Finalizar) para completar este processo.  

 

 

 

 

 

 

 

 

4. Agora você pode entrar seus dados neste arquivo de banco de dados.  

 

 

 

 

 

 

 

 

 

 

6.2 Abra um Arquivo de Banco de Dados Existente  

 

O formato padrão dos arquivos de banco de dados para DBMaker é o formato *.mdb. 

Você pode abrir arquivos de banco de dados existente editado por Access. Abra os 

arquivos *.mdb a partir de Menu Bar：File Open (Barra de Menu : Arquivo  

Abrir) ou abra arquivos a partir da Barra de Ferramentas： . 

 

6.3 Editar uma tabela do banco de dados 

 

Depois de você criar um novo arquivo de banco de dados ou depois de você abrir um 

arquivo de banco de dados existente, você pode começar a editar sua tabela no 

arquivo de banco de dados.  
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1) Modificar Campo 

Iniciar a partir de Menu Bar：Field Modify Field (Barra de Menu : Campo  

Modificar Campo).  Um quadro de diálogo aparecerá, e você poderá pressionar 

[New] (Novo) para adicionar um campo novo ou pressionar [Delete] (Deletar) para 

deletar um campo.  

 

 

 

 

 

 

 

 

 

Também, você pode clicar diretamente no botão direito do mouse no campo que você 

deseja modificar e você terá as seguintes opções: Descent Sort (Classificar por 

Ordem Descendente), Ascent Sort (Classificar por Ordem Ascendente), Delete Field 

(Deletar Campo), Cut (Cortar), Copy (Copiar), Paste (Colar), e configuração de  

Primary Key (Chave Primária). 

 

 

 

 

 

 

 

 

2) Adicionar/Deletar Registro 

Selecione Menu Bar：Record Add Record ou Delete Record (Barra de Menu : 

Registro  Adicionar Registro ou Deletar Registro).  

 Add Record (Adicionar Registro)：Uma vez que você selecione [Add 

Record] (Adicionar Registro) o cursor moverá automaticamente para a 

última linha da tabela e o usuário poderá entrar os dados.  
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 Delete Record (Deletar Registro)：Quando você seleciona [Delete 

Record] (Deletar Registro) a linha inteira que está indicada pela flecha, 

será deletada.  
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6.4 Configurações para Pré-visualização das Imagens  
 

1. Primeiro, você precisa salvar todos os arquivos de imagens, que você 

necessita em uma mesma pasta (O usuário pode procurar o caminho da pasta 

ou entrar o caminho da pasta diretamente no espaço em branco de  [File 

Folder] (Pasta de Arquivo) mostrado como A na seguinte ilustração).   

2. Digite todos os nomes de arquivo sequencialmente em um certo campo do 

banco de dados (mostrado como B na seguinte ilustração). Por exemplo, se 

você colocar todos os arquivos de imagem na sub-pasta ”PM” que está na 

pasta “CStest” no disco D, e você também digitar todos os nomes do arquivo 

imagem em um campo chamado “Photofield” em seu banco de dados. Digite 

“D:\CStest\PM\” no espaço em branco de [File Folder] (Pasta de Arquivo) 

ou pressione [Browse] (Procurar) para o caminho da pasta dos arquivos de 

imagem.  

3. Selecione Field Name (Nome de Campo) na lista pendente de [File Name] 

(Nome de Arquivo) (mostrado como C na seguinte ilustração) e selecione 

“.jpg” no espaço em branco de [File Extend] (Extensão de Arquivo) 

(mostrado como D na seguinte ilustração). Em seguida, a imagem onde está 

localizada a flecha (mostrado como E na seguinte ilustração) será mostrado 

na área de pré-visualização.  

 

 

 

 

 

 

 

 

 

 

 

A

B

C
D

E 


